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Introduction to CapitolTrack 
The CapitolTrack User Guide was designed to walk you through the latest version of our legislative bill 

tracking software, version 3.  If you ever have any questions when working in CapitolTrack, please don’t 

hesitate to call us at (916) 373-0126 and press “0” for the next available person. 

  

Technical Specifications 
CapitolTrack 3 is compatible with Internet Explorer 7 or newer. It will also work with Firefox and 

Chrome, but our best results are with Internet Explorer. 

 

Training 
We have training videos available on our website.  You can access them by going to 

www.CapitolTrack.com, clicking on Resources, and then Training Videos. 

 

After watching the videos, if you would like additional training on CapitolTrack, please call us at 

(916) 373-0126. 

 

http://www.capitoltrack.com/
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Logging In 
To login to CapitolTrack please go to http://www.capitoltrack.com 

Enter your username and password at the top of the screen 

 
 

Picking a Session 

 
You will automatically be logged into the current legislative session.  If you need to access 

information about bills from a previous legislative session, please use the drop down at the top of 

the page to pick the session you need. 

 

http://www.capitoltrack.com/
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Mobile Website 

 
We have a mobile-optimized website that can be used on any smartphone or tablet.   

Go to http://m.capitoltrack.com and login with your username and password. 

 

Note: If you are unable to login, please check your cookies settings.  Cookies must be enabled so our site 

can remember your login information. 

 

The site is designed to help you find what you need when you’re on the go. 

 

Bill Search 

 

http://m.capitoltrack.com/
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Type in a number, and Bill Search will pull up all bills with that number.  We also show the author, 

topic and status of the bill to be sure you’re looking at the correct bill.   

 

 
Click on the bill to see the full status, location, calendar event, basic tacking information, text 

history, analyses and votes for that bill. 

 

Reports 

 
These reports show changes since yesterday; however, on Monday they show all updates since 

last Friday.   
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Member Roster 

 
Names are sorted alphabetically by last name.  Click a member’s name to see house, room, 

district and party… and a picture! 

 

Calendar 

 
See which of your bills are scheduled to be heard on the floor, or in an upcoming committee.  
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Quick Overview 

 
To view bill information and reports, you should be on the Workspace tab. 

 

 
Use the Bill Search Bar to jump to the bill you want to track. 

 

 
On the Bill Information page, scroll down until you see the Bill Tracking section on the left side. 

Click on the blue Add Tracking Form button. 

 

 
Make your tracking field selections for this bill. 

You may add new tracking field selections using the right-hand column.  In this instance, we typed in 

“ABC Company” in the Organization row and clicked add field.  We then had the option to start tracking 

this bill for ABC Company. Click the Save button. 
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To run a report (e.g. a Status Report), begin by clicking on Workspace in the top, left corner. 

From Workspace, click on New Report on the dark green toolbar. 

 

 
The Report View tab allows you to choose what information to display on your report. 

The other four Filters tabs allow you to choose which bills to display on your report. 

To display your report, click on Close and refresh report in the top, right corner. 

 

 
Here is a sample report that was created in CapitolTrack. 
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Today’s Events 

 
Click on Today’s Events on the top, right corner to see the following information: 

 

What’s Happening at the Capitol Today 

 
When you click on Today’s Events you get a snapshot of what’s happening at the California 

Capitol today.  To view all non-measure hearings that are scheduled on future date, click the “for 

more” link. 

 

 
The header at the top of the page displays: 

 Upcoming legislative deadlines 

 A place to provide feedback to CapitolTrack 

 Any messages from CapitolTrack to our users (system updates, new features, etc.) 

 

The dropdown lets you view additional calendar resources, including: 

 Joint Session Schedule 

 Budget Item calendar 

 Calendars for each Budget Subcommittee 

 Current Daily Files 
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Search Bars 
The Search Bars allow you to quickly jump to a specific bill, or search for similar bills. 

 

Bill Search Bar 

 
Use the Bill Search Bar drop downs to jump to a bill of interest without having to remember the 

exact prefix 

 

Keyword Search Bar 

 
Use the Keyword Search Bar to find all bills containing your keyword or phrase.   

The results of your search will: 

 Display all applicable bills 

 Show where the keywords were found in the text 

 Allow you to start tracking the bill directly from the search results 

Note: You can narrow your keyword search (e.g. look for only non-tracked bills) by clicking on 

Edit Current Report 

 

Author Search Bar 

 
Use the Author Search Bar to find all bills by a specific author 

Note: As with the keyword search you can narrow your search (e.g. only include bills that have 

been chaptered) by clicking on Edit Current Report 

 

Smart Search Bar 

 
Use the Smart Search bar to find any type of information in CapitolTrack.  Based on your entry 

the system will know if it’s a Bill, a Keyword, an Author, etc.   

This also allows you to avoid dropdowns and just type in what you need to find. 

Note: You can always click on Edit Current Report to further refine your search. 
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Workspace – Bill Information 
The Bill Information screen is the place to go to find what you need about a specific bill.  You can use the 

Bill or Smart Search Bars to jump directly to a Bill Information screen, or click on a measure number from 

a report. 

 

Print/Email Bill Information 

 
Click on this button to view bill information on one, easy-to-print (or email!) page.  Using this view 

also ensures that your CapitolTrack account information stays secure.  You’ll notice that clicking 

on text links takes you to the public Leginfo site, so they do not have access to your account. 
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Bill Characteristics 

 
These icons give you at-a-glance charateristics about the bill.  From left to right, these icons 

represent: 

 Active (Inactive if crossed out) 

 Appropriations (Non-appropriations if crossed out) 

 Fiscal (Non-fiscal if crossed out) 

 Non-tax Levy (Tax Levy if not crossed out) 

 Urgent (Non-urgent if crossed out) 

 State Mandated Local Program (Not a State Mandated Program if crossed out) 

 2/3 Vote Required (Majority vote required if the icon has four boxes with three filled in) 

 

If you place your cursor over any of the icons while in CapitolTrack, the explanation will appear. 

 

Support & Opposition 

 
Click this button to view which organizations have submitted a letter of support or opposition to a 

committee.  Support & Opposition is listed in date order with the most recent at the top.  If there is 

a note that says “Pending Review” this means that our staff needs to review this analysis for 

accuracy.  Check back in a little while and the list should be available. 

 
This is what the Support & Opposition screen will look like. 

 

Calendar Events 

 
If the bill is scheduled to be heard on the floor or in committee, the date, time, location, and 

chairperson (if applicable) will appear under Calendar Events.  If a bill is scheduled to be heard in 

more than one place, all scheduled hearings will appear in this section. 
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You can also create calendar reports which will show you all the bills scheduled to be heard that 

fit a certain criteria (e.g. all your tracked bills).  For more information on how to create this report, 

please see the Workspace - Reports section of the User Guide. 

 

Note: CapitolTrack has many sources for knowing when/where a bill will be heard next.  If you 

see a Calendar Event marked as “Anticipated Hearing” that means it has not been scheduled in 

the Daily file, but other sources have told us when and where it should be scheduled next. 

 

It is our policy to leave Anticipated Hearings in the calendar until the day of the hearing.  If the 

hearing has not been confirmed in a Dailyfile, we will remove the event from CapitolTrack. 

 

Author 

 
This section gives some information about the author of the bill.  Clicking on the member’s name 

takes you to his/her website. 

 

Status and Location 

 
The Current Status tells you what last happened to a bill.  When we’re monitoring hearings, this 

will be where we post updates on things like vote results. 

The Current Location tells you who currently has ownership of the bill. 

 

Progress Bar 

 

 

 
The visual progress bar shows you where in the legislative process the bill currently is.  If it 

reaches certain stages (e.g. vetoed or chaptered) the background turns a different color to make 

the location easier to identify. 

 

You can also run reports that include this visual progress bar for each bill on the report.  For more 

information on how to include the progress bar on your reports, please see the Workspace – 

Reports > Create a New Report > Report View Tab > Items to Display > Progress Bar section of 

the User Guide. 
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Bill Tracking 

 
This is where you can view information about bills that you are tracking.  For more information, 

please see the Tracking Form section of the User Guide. 

 

Bill Text – Display Options 

 
This is where you can find each version of the Bill Text.  The most recent version will always 

default to the top, but previous versions can be found using the dropdown menu. 

 

HTML 
Choose the version of text you need to read and click HTML.  We have done a number of 

things to enhance the HTML Bill Text, including: 

 

Word Cloud 

 
The Word Cloud gives you an at-a-glance idea of what the bill is about.  Our 

system scans the bill text and then emphasizes the words that are used most 

often. 

 

To view the Word Cloud, click on the arrow on the right side of the grey bar at the 

top of the HTML Bill Text. 
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Color-Coded Text 

 
Changes to Bill Text are much easier to find now, thanks to our color coded text.  

If words or phrases are being added to this version of the text they’ll be in blue 

italics.  If they’re being removed from this version of the text, they’ll be in red 

strikeout. 

 

Code Section Links 

 
Anywhere a code section is referenced in the HTML text, CapitolTrack has 

created a link that will display how that code section currently reads. 

 

PDF 
Choose the version of text you need to see and click PDF.  This will open the Bill Text in 

a PDF document, thus displaying the line numbers in the text and formatting the text to 

be printed. 

 

Word 
Choose the version of text you need to see and click Word.  This opens up the PDF 

version of the text in a Microsoft Word document.  The Word format for bill text is ideal for 

anyone who needs to see the line numbers in the text, but wants to be able to make 

changes to the text and “mock-up” or “redline” a bill. 
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Bill Text – Amends the Law 

 
Amends the Law is a powerful feature that allows you to see how the law would read if a bill 

where to chapter today.  While each Bill Text shows you what changes have been made since 

the previous version of the text, Amends the Law lets you see what the bill is actually changing. 

 

Bill Analysis 

 
As Analyses are released for a bill, they will show up in this section with the most recent 

defaulting to the top.  Use the dropdown menu to access previous analyses.  Choose the analysis 

you need and click on the HTML or Word buttons to view the text.  (The Word option is print/email 

friendly!) 

 

Votes 

 
We save the vote history in the Votes section with the most recent vote defaulting to the top.  Use 

the dropdown menu to access previous votes and click on the HTML button to the right to view 

which member voted which way. 
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Department of Finance Analysis 

 
As the Governor's chief fiscal policy advisor, the Department of Finance analyzes proposed 

legislation for fiscal impact and alignment with the Governor's Administration's policy priorities. 

The DOF reports its findings and support position through Bill Analyses and these are available in 

CapitolTrack as soon as they are made public. 

 

My Bill Alerts 

 
You can elect to receive email notifications whenever the status of a bill changes.  With multiple 

logins you can also pick which email address those notifications should go to. 

 

To begin receiving email alerts on a bill simply go to the Bill Information screen for the bill of 

interest, and check the “Notify?” box for the user(s) who should receive the updates. 

 

For instructions on how to change the email address assigned to each username, please see the 

My Tools > Maintenance: Email Maintenance section of the User Guide. 

 

To manage email notifications for each login, please see the My Tools > Maintenance: 

Notifications section of the User Guide. 

 

Here is a sample Bill Alerts email: 

Subject: Bill Notification: AB 1019 7/4/2012 4:12:00 AM 

 
 

You can request additional information be included in the subject and body of your email alert by 

filling out our customization form. 

 

http://www.capitoltrack.com/PersonalizedNotifications/tabid/442/Default.aspx
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Other Bill Info  

This section contains a variety of other information related to the bill.  Sections include: 

 

Bill Text Summary 

 
There are four types of summaries to view for each bill: 

 

Short Summary 
The Short Summary is taken from the Leg Counsel digest and it gives a brief 

overview of what existing law does and how the bill would change it.  If there is 

additional information in the digest, there will be a sentence at the end of the 

summary saying “This bill contains other related provisions and other existing 

laws.”  

 

Long Summary 
The Long Summary is taken from the Leg Counsel digest and gives the full 

description of the bill. 

 

Digest 
The Digest is written by Leg Counsel and is an overview of what existing law 

does, how the bill would change the law, and what the bill characteristics are.  

(e.g. Appropriation, Fiscal Committee, Required vote, etc.) 

 

User Summary 
The User Summary allows a subscriber to enter his/her own summary for a bill.  

(For instance, you can describe how that bill would directly affect your company.)  

When a User Summary is entered it replaces all other summaries on reports. 
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Bill History 

 
View the history of the bill. 

 

Bills Affecting Same Code 

 
Use Bills Affecting Same Code to see what other bills are affecting the same code 

section that the current bill does.  This will allow you to see if you might have a chaptering 

out problem with another bill.  You can also see if you are tracking the other bills and can 

link directly to the other Bill Information screens by clicking on the bill number. 

 

People Also Track 

 
Use People Also Track to get an idea of what similar bills other people are tracking.  (If 

you have ever been to Amazon.com and seen their “Customers Who Bought This Item 

Also Bought” section, this is the same idea.) 
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Governor’s Message 

 
If the Governor includes a chapter or veto message, it can be found under this tab.  You 

can also run reports that include the Governor’s Message.  For more information, please 

see the Workspace - Reports section of the User Guide. 

 

My Attachment/Links 

 
CapitolTrack allows you to attach files and website links to your Bill Information page.  

This allows you to manage your files and information, and view these items anywhere 

that you have web access.  You can also run reports that contain links to these items: For 

more information, please see the Workspace - Reports > Create a New Report > Report 

View Tab > Items to Display > Attachments section of the User Guide. 

 

To add an attachment or link, begin by typing in the name you want displayed for the 

attachment (in this case we called the attachment “Banking and Finance – Bill Letter”).  

To attach a file, click on the blue “Upload a File” button, find the file you need to attach, 

and click on “Open.”  To save a link to a website, enter the web URL and click on the blue 

“Save URL” button. 

 

After uploading a file or saving a URL, the screen will refresh and you will see your 

attachment under the My Attachment/Links header.  It will have today’s date (the day you 

created the attachment), the display name you chose, and an option to delete the 

attachment. 
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Tracking Form 
The Tracking Form lets you store your company’s information and preferences about any bill.   

 

Note:  Setting up your tracking form for the first time is important because it impacts the way you track all 

bills within CapitolTrack.  For help and advice on setting up your tracking form and discussing different 

options, please contact the CapitolTrack staff. 

 

Adding a Tracking Form 

 
If you are not already tracking the bill, you can go to the Bill Information page and locate the Bill 

Tracking section on the left side of your screen.  To begin tracking a bill, please click on the blue 

Add Tracking Form button.   

 

Completing a Tracking Form 

Filling out a tracking form lets you save your information and preferences about that bill.  The first 

time you log into your CapitolTrack, the middle section of your tracking form will be blank.  This is 

because the tracking form was designed to be fully customizable to fit your needs, so we let you 

add the tracking options you want.  Please see the Add Tracking Selections section below to 

learn how to add options to the middle section of your tracking form.   
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Current Tracking Selections 

 
The section on the left shows the fields that are available to track your bills in different 

ways.  The default fields are Organization, Assigned, Position, Priority, etc.; but these can 

be changed to fit your needs.  If Organization isn’t helpful but Client is, please let 

CapitolTrack know and we will make the change.  A request form can be found in 

Appendix B of the User Guide. 

 

Choose Tracking Selections 

 
Use the middle column to choose your tracking selections for this bill.  You do not have to 

pick an option in every field in order to track a bill.  If you do not choose any tracking 

selections but click the Save button, that bill will still be part of your tracked bills list. 

 

You will notice there are two main types of tracking fields available: 

 

Fields with radio buttons that allow one selection at a time – useful for tracking things 

such as your position since you’re never going to have a bill with two different positions at 

once. 

 

Fields with check boxes that allow multiple selections at a time – useful for tracking things 

where more than one option apply, such as the subject of a bill. 

 

Note:  You can edit or delete your tracking options.  For instance, if Jennifer were to 

leave the company and be replaced by Clint, you could simply change Jennifer to Clint 
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and all Jennifer’s bills would automatically be re-assigned.  For information on how to edit 

or delete your tracking choices, please see the My Tools > Maintenance > Tracking Field 

List section of the User Guide. 

 

Vote 

 
The vote field helps you run analysis on the bills you’re tracking.  After selecting 

whether you prefer a “yes” or a “no” vote on each of your bills, you can run 

reports on which legislative members consistently do or don’t vote the way YOU 

want them to.  For more information on how to run the Vote Score analysis, 

please see the CT Analyze > Vote Score section of the User Guide. 

 

Due Date 

 
The Due Date field allows you to set a date for a bill and then run reports that 

sort by that date.  This can be used in a variety of ways; for instance, you can 

mark the dates that you need analysis back by and then keep a report of what 

deadlines are coming up. 

 

Add Tracking Selections 

 
If you need a new tracking option, simply type it in the right hand column and click the 

add field link. 
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Editing a Tracking Form 

 
If you are already tracking a bill, you can edit your tracking preferences by clicking the Edit link on 

the right. 

 

Archiving and Deleting Tracking Forms 

 
There are a number of reasons why you might not need to track a bill anymore.  Perhaps the bill 

was amended so it no longer impacts your client, or maybe the bill failed a legislative deadline 

and you no longer want it to appear on your active bill reports.   

 

If this is the case, CapitolTrack gives you the ability to archive the tracking form.  This will remove 

it from you active tracking lists, but retains the tracking information for future reference.  At the 

end of a two year session, you can create reports that show all your active and archived bills for a 

full picture of the session.  For more information on how to create reports with your tracked and 

archived bills, please see the Workspace – Reports > Create New Report >Bill Filters section of 

the User Guide. 

 

For more information on how to auto-archive a group of bills (e.g. all 2 year bills, all 

chaptered/vetoed bills, all dead bills), please see the My Tools > Archive section of the User 

Guide. 

 

You may also decide that you want the tracking form deleted completely.  If this is the case, click 

the Archive button and you will then have the option to delete the tracking form. 

 

Adding Tracking Forms to Multiple Bills at Once 

 
To begin tracking multiple bills at once, click the Add Tracking Form button on the first bill you 

want to add, then type in the other bill numbers in the text box just below the topic.  You may 

make tracking selections for these bills as long as you have the same preferences for every bill in 

the group. 
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Adding Tracking Forms for Multiple Clients (Multiform) 

 
 Some organizations take only one position on a bill at any given time.  For instance, it makes no 

sense for an association to both support and oppose a bill at the same time!  For organizations 

such as this, CapitolTrack allows one tracking form per bill. 

 

Other organizations need to take multiple positions on a bill.  For instance, a lobbying firm may 

need to track a bill for clients ABC and XYZ, but those clients may not have the same position.  

For organizations such as this, CapitolTrack allows multiple tracking forms (known as Multiform) 

for each bill.  If your company needs the Multiform feature turned on, please call us at (916) 373-

0126 and we can turn it on at no charge. 

 

Using the Notes Fields 

 
The Notes and Memo fields can be used to store different types of typed information.  The Notes 

fields support plain text and the Memo field supports rich text formatting.  CapitolTrack has 

provided multiple Notes fields to allow you to store different types of information that can then be 

included in reports.  For instance, your office might use Notes 1 to store internal notes about 

when letters were sent to committees or legislative members and Notes 2 could be used to 

summarize progress for your client.   

 

Note:  CapitolTrack can also rename the fields so instead of saying Notes 1 and Notes 2, the 

headers could say Internal Notes and Client Notes.  Please contact us to make these changes. 

 

Tracking Suggestions 

 
The tracking form is designed to be the one-stop place to keep all information about your bills.  

When you’re setting up your tracking form, think about your bill tracking process and how the 

CapitolTrack tracking form can help manage that process.   

 

For example, you can use the tracking form to track where you are in your analysis process.  If 

these are your steps in the analysis process, 

Step 1: Request Analysis 

Step 2: Receive Analysis 

Step 3: Submit Analysis to Policy Director 

you can enter those three steps in a tracking field, and mark each bill according to what step that 

bill is on.   
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Marking each bill then allows you to create reports to view which bills are on what step of the 

process.  For more information on how to create reports, please see the Workspace – Reports > 

Create a New Report section of the User Guide.  

 

 
Some organizations need to track information related to each version of a bill.  One way to 

tracking this information is to use the Memo field at the bottom of the tracking form.  The field 

allows rich-text formatting so you can create a template table and then add new rows every time 

a new text version is released.   

 

For more information on how to set-up your Memo field template, please see the My Tools > 

Maintenance > Memo Template, section of the User Guide. 
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Workspace – Reports 

 
If you need to view a select group of bills in CapitolTrack, you can create go to the Workspace and run a 

report.  CapitolTrack reports let you decide which bills you need to display and what information you need 

to show for each bill.  This section of the User Guide discusses all your report options. 

 

For step-by-step instructions on how to create common reports, please see Appendix A – How To Create 

Common Reports in the User Guide. 

 

Default Reports 

 
There are eight default reports available in every CapitolTrack account.  You can create other 

categories that contain reports, but these five reports will always display at the bottom of the list. 
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Bill Count 

 
The Bill Count report gives you statistics on the number of bills with different 

characteristics.  You can see the numbers for both the first and second years of the 

session, and for all the bills (All) and just the bills you’re tracking (Mine).  These numbers 

can be very useful at the end of the two year session! 

 

Gut & Amend 

   
CapitolTrack maintains a daily Gut & Amend report with the most recent changes at the 

top.  If a bill had a full text change, a change in author or a change in topic, CapitolTrack 

will display the new author and topic in italics and the old author and topic in strikeout. 

 

Committees/Committees by Room 

 
CapitolTrack maintains a list of standing and select committees.  If you would like to use 

this list to create a mail merge (for letter, labels, etc.) you can use the Data File export 
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feature.  For more information on how to create a Data File, please see the Export – Data 

File section under Workspace – Reports in the User Guide. The Committees by Room 

option sorts committee members by room number in descending order to make letter 

delivery easier. 

 

Members/Members by Room 

 
CapitolTrack also maintains a list of contact information by legislative member.  If you 

would like to use this list to create a mail merge (for letter, labels, etc.) you can use the 

Data File export feature.  For more information on how to create a Data File, please see 

the Export – Data File section under Workspace – Reports in the User Guide. The 

Member by Room option sorts Assembly/Senate members by room number in 

descending order to make letter delivery easier. 

 

Calendar 

 
This was designed to give you a jump start on creating calendar reports.  As the 

message box indicates, this will give you a calendar of all bills scheduled to be heard on 

the floor or in committee.  If you need a more specific calendar; for instance, a calendar 

of just the bills you’re tracking, or just your priority bills, you may click the Edit Current 

Report text and filter down on the type of bills that should be displayed. 

ICAL Button 

 
Each calendar event will have a green button that says “ICAL.”  If you use an 

electronic calendar that supports the ICalendar format (such as Microsoft 

Outlook), you can click on the button and add the event to your calendar. 
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Today’s Updates 

 
This was designed to give you a jump start on creating a report of today’s updates.  As 

the message box indicates, this will give you a report of all bill status updates posted 

throughout the day. If you need a more specific report; for instance, a report of just the 

bills you’re tracking, or just your priority bills, you may click the Edit Current Report text 

and filter down on the type of bills that should be displayed. 

 

Create a New Report 

 
To create a new report in CapitolTrack, please be sure you are in the Workspace, and then click 

on New Report on the dark green Report Actions Bar.   

 

 
This pops open the Report Filters box to create your report.  You will notice at the top that there 

are five green tabs: Report View, Bill Filters, Tracking Form Filters, Keyword Filters, and Code 

Section Filters.  Each tab is discussed below, but it is important to notice that the first tab uses the 

word “View” and the other tabs use the word “Filters.”  This is because the Report View tab is 

used to pick what information you want to view on your report, whereas the other four tabs are 

used to filter down on specific types of bills. 

 

Keep in mind that your report will be created based on all four filter tabs, so the more boxes you 

check, and the more information you input, the more refined your search will be.  If you enter a 

keyword on the Keyword Filters tab, and a code section on the Code Section Filters tab, the 

report will only display bills that contain your keyword AND affect the code section you listed. 
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Report View Tab 
This tab is used to define how you want your report to look. 

 

Primary and Secondary Header 
These fields are used to insert titles at the top of your report.  The Primary 

Header is the first line and the Secondary Header is the second line.  If you 

would like your report to show today’s date each time its run, click on “insert date 

macro” on the right. 

 

So filling out the Primary and Secondary Header like this… 

 
Will display at the top of your report like this… 

 
 

The short date looks like this: 6/12/2009 

The long date looks like this: Friday, June 12, 2009 

The date looks like this: 8:23 am 

 

Format 
The Format section is an important box because it drastically affects the way you 

view your report.  Please see below for the Format options and how each of 

those affect your report. 

 
 

Note: You will notice that each sample report below displays the EXACT SAME 

INFORMATION.  They all show the bill number, author, topic, organization, 

assigned, position, and priority; however, each report displays those items in a 

different format.   

 

On the calendar formats, a bill is only displayed if it is scheduled to be heard on 

the floor or in committee.  That is why SB 59 in the following examples is 

displayed on the report formats, but not on any of the calendar formats; it is not 

calendared to be heard. 

 

If your calendar includes floor events, the next floor time for the Assembly and 

Senate will automatically be included at the top. 

 



36 | P a g e   R e v  3 . 2 . 2 2  
 

Default Format 

 
Default format organizes tracking form information in columns. 

 

Calendar Format 

 
Calendar format displays bills in the order they are scheduled to be heard on the 

floor or in committee, and lists the tracking form information in columns. 

 

Note:  If a bill is not scheduled on the legislative calendar, it will not appear on 

this report. 
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Default Row Format 

 
Default Row format organizes tracking form information in rows.  This is a great 

format to use if you’re moving your report over to Microsoft Word for further 

editing. 
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Calendar Row Format 

 
Calendar Row format displays bills in the order they are scheduled to be heard 

on the floor or in committee and lists the tracking form information in rows.  This 

is a great format to use if you’re moving your report over to Microsoft Word for 

further editing. 

 

Note:  If a bill is not scheduled on the legislative calendar, it will not appear on 

this report. 
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Calendar Matrix Format 

 
Calendar Matrix format displays bills in the order they are scheduled to be heard 

on the floor or in committee and lists the tracking form information in a grid and 

can easily be transferred into Microsoft Excel. 

 

Note:  If a bill is not scheduled on the legislative calendar, it will not appear on 

this report. 

 

 

Matrix Format 

 
Matrix Format displays information in a grid and can be easily transferred into 

Microsoft Excel and similar programs. 
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Personalized Formats 
If you need a report to look a specific way that is different from the formats listed 

above, please let CapitolTrack know!  We can help you avoid hours of cutting / 

pasting to make your report look “just right.”   CapitolTrack offers personalized 

formats free of charge and we will do the work to make your reports look the way 

you need them to.  For more information on Personalized Formats, please see 

Appendix B in the User Guide. 

 

Sort By 

 
This feature allows you to sort/group bills based on a specific field. 

 

Some of these options are specific to the bill (Measure, Author, House, Location, 

Text Date, Chapter Number and Deadline.) 

 

Other options are specific to your tracking form (Assigned, Organization, Due 

Date, Group, Misc1, Misc2, Office, Position, Priority and Subject.) If you have 

customized your field labels, the list in your account may look slightly different.  
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In this example, the report was sorted by Organization so all the bills for ABC 

Company are under one header, and all the bills for XYZ Company are under 

another header. 
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The only field that really need explanation is the Deadline option. Sorting by 

Deadline will show you which legislative deadline each bill is up against next. If a 

bill is exempt from deadlines, it will be sorted to the bottom of the report under an 

Exempt section. 

 

 

 



43 | P a g e   R e v  3 . 2 . 2 2  
 

Paginate Report 

 
This feature allows you display bills in one long list (Paginate = No), or view them 

in sets of 20 bills per page (Paginate = Yes).   

 

 
Large reports will load faster if you paginate the report, and you can easily jump 

to different pages using the toolbar that appears at the top of the report. 

 

Include Calendar Events 

 
This option appears when you choose one of the Calendar formats.  You may 

choose to run a calendar of just Floor hearings, or just Committee hearings.  

Checking both boxes or leaving both boxes blank will display Floor and 

Committee hearings. 

 

Items to Display 

 
All reports display the bill number, author and topic, but there are many other 

types of information you can choose to display on your report.  Most are self-

explanatory, but we’ve explained some of the more cryptic options below. 

 

Current Text Version 

 
Displays the most recent version of text and provides links to the PDF and HTML 

version of that text. 

Introduced Date and Last Amend Date 

 
Displays the date the bill was introduced, and the date of the most recent 

amendment. 
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Status and Location 

The Status tells you what last happened to a bill.  When we’re monitoring 

hearings, this will be where we post updates. 

The Location tells you who currently has ownership of the bill. 

 

Calendar 

 
Displays the date, time and location of any upcoming floor or committee 

hearings.  If there is no upcoming hearing for this bill, the Calendar item will not 

display. 

 

Summary Brief vs. Summary Short 

 
Summary Brief describes what the bill would do. 

Summary short describes current law and then what the bill would do to change 

that. 

 

Laws 

 
Displays which code sections this bill would affect and what it relates to. 

 

Vote Events 

 
Displays a summary of past votes. 

 

Is Fiscal Flag and Is Urgency Flag 

 
These will display whether or not each bill is a fiscal bill, and whether or not each 

bill is an urgency bill. 

 

Progress Bar 
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The Progress Bar gives you a visual idea of how far through the legislative 

process the bill currently is.  This is a great tool for reports that are given to 

people who are unfamiliar with the steps a bill takes to become law. 

 

 
Bill has failed a legislative deadline, and is 2 YEAR or DEAD 

 

 

 

 
Bill is moving through its first house (Assembly for AB bills, and Senate for SB 

bills) 

 

 

 

 
Bill is moving through the opposite house (Senate for AB bills, and Assembly for 

SB bills) 

 
Bill is in conference or concurrence 

 
Bill is in enrollment or is enrolled 

 
Bill has been vetoed by the Governor 

 
Bill has been adopted or chaptered 

 

Text History 

 
Displays a summary of the text versions for the bill. 
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Current Analysis 

 
Show the most recent analysis for the bill, includes the text date the analysis is 

based on, and has a link to the document. 

 

Attachments 

 
If you attach any letters or website addresses to your Bill Information Screen, this 

will display those attachments and hyperlink to the document. 

Last Reviewed 

 
This lets you log the date and time that you reviewed a bill.  Click the purple 

“Reviewed” link and your report will automatically update with the current date 

and time for your login.  You can also see when others in your office have 

reviewed the bill. For more information about this, please go to our Training 

Video page and watch the video that shows how to use this feature. 

 

Sort By Links 

 
When you sort by a field other than “Measure,” you can use Sort By Links to 

create shortcuts to the different headers.  In this example, clicking on either link 

would take you directly to the part of the report that lists the bills for ABC 

Company or XYZ Company. 

Sort Counts 

 
When you sort by a specific field, you can choose to include a count of how many 

tracking forms and how many measures appear under each header.  In this 

example, we sorted our bills by Author, and told us display Sort Counts.  There 

were 18 bills on our report under the Author “Aanestad.” 

 

Note: To view the sort counts, please run your report and click the Print/Email 

button or PDF - Export button.  Simply running the report in your Workspace will 

not display the sort counts. 

 

http://www.capitoltrack.com/Resources/TrainingVideos/tabid/441/Default.aspx
http://www.capitoltrack.com/Resources/TrainingVideos/tabid/441/Default.aspx
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Manage Bill Links 

 
Let’s you manage actions on multiple bills at one time. Add tracking form lets you 

to go straight to the tracking form to add a bill to your file.  Mark reviewed is used 

in conjunction with the Last Reviewed option. Check the boxes next to the bills 

and use the dropdown to select what action should be taken. 

 

To begin tracking a single bill click the green Add button. To sign up for email 

alerts on a bill, click the Notify button. 

 

 
You can also use this feature to manage the tracking forms for the bills you’re 

currently tracking.  Click on the Edit or Archive links to the left of Organization. 

 

Bill Filters Tab 
This tab is used to create a report with only certain types of bills displayed. 

 

Source 

 
Use this section to filter on bills by their tracking status.  You can choose from all 

your tracked bills, specifically bills you’re not already tracking, or bills that you 

were tracking but have archived the form. 

 

 

Last Reviewed 

 
This hides bills that have been reviewed since their most recent text change.  

The filter should be used in conjunction with the Last Reviewed checkbox on the 

Report View tab.   

 

If you create a report of bills amended yesterday and turn on this filter, you’ll 

notice that bills disappear from the report as soon as you click the purple 

Reviewed button.  This is a great way to go through reports at your leisure and 

be sure that nothing was missed. 
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The dropdown lets you choose whether a bill should be hidden after you review 

it, or anyone in your office reviews it.   

 

Versions 

 
There are two parts to this section, and combined they can be very powerful.   

 

The first allows you to find text versions or motions that were released either 

since a specified date, or within the last certain number of days.  (It is only 

necessary to fill in a date OR a number of days… not both.) 

The second allows you to search for only bills with a certain text version, or a 

motion. 

 

So if you’re looking for bills that were amended since yesterday, you check only 

the Amended/Proposed box and put a 1 in the ## box.  If you came in on Monday 

and wanted to see anything since the previous Friday, you would put a 3 in the 

box. 

 

Note: The version date is looking up the posted date in CapitolTrack, not the 

listed date for the text.  What does that mean?  Well, let’s say you have a report 

that shows you all text changes since yesterday.  If a bill was introduced on 

2/27/2009, but the text wasn’t released until 3/3/2009, that could be a problem if 

we went by the text date!  Instead, CapitolTrack will pull up text on 3/4/2009 

because the text was posted in our system the day before.  That way, you’ll 

never miss a thing! 

 

Author 

 
If you need to filter on just bills by specific author(s), use this section to choose 

which authors should be included. 
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Location 

 
Use this section to include or exclude bills that are in a certain location.  This can 

be useful to find which bills were marked 2 YEAR or DEAD when they are 

marked in CapitolTrack.  You can also use this section to see which bills are still 

active at the end of the year.  Just exclude the following locations: 2 YEAR, 

ADOPTED, CHAPTERED, DEAD, or VETOED. 
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Here’s a translation of what the committee acronyms mean: 

A. & A.R. Accountability and Administrative Review 

A.,E.,S.,T., & I.M. Arts, Entertainment, Sports, Tourism and Internet Media 

AGING & L.T.C. Aging and Long-Term Care 

AGRI. Agriculture 

APPR. Appropriations 

B. & F. Banking and Finance 

B. & F.I. Banking and Financial Institutions 

B., P. & E.D. Business, Professions and Economic Development 

B.,P. & C.P. Business, Professions and Consumer Protection 

BUDGET & F.R. Budget and Fiscal Review 

E. & C.A. Elections and Constitutional Amendments 

E. & R. Elections and Redistricting 

E. U. & C. Energy, Utilities and Communications 

E.Q. Environmental Quality 

E.S. & T.M Environmental Safety and Toxic Materials 

ED. Education 

G. & F. Governance and Finance 

G.O. Governmental Organization 

H. & C.D. Housing and Community Development 

HIGHER ED. Higher Education 

HUM S. Human Services 

INS. Insurance 

J., E.D. & E. Jobs, Economic Development and the Economy 

JUD. Judiciary 

L. & E. Labor and Employment 

L. & I.R. Labor and Industrial Relations 

L. GOV. Local Government 

N.R. & W. Natural Resources and Water 

NAT. RES. Natural Resources 

P.E. & R. Public Employees and Retirement 

P.E.,R. & S.S. Public Employees, Retirement and Social Security 

PUB. S. Public Safety 

REV. & TAX Revenue and Taxation 

RLS. Rules 

T. & H. Transportation and Housing 

TRANS. Transportation 

U. & C. Utilities and Commerce 

V.A. Veterans Affairs 

W.,P. & W. Water, Parks and Wildlife 

 

 

Manual Bill List 

 
A majority of the time you can create a report in CapitolTrack using one of the 

many other filters available.  The nice part of using other filters is that your 

reports will automatically update with changes.  But there’s the rare occasion 
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where you can’t create a list of bills with any other filter, so you can use the 

Manual Bill List to create a report with specific bills included.  CapitolTrack 

recommends using this list as a last resort when creating reports. 

 

Tracking Form Filters 

 
This tab is used to filter your report based on you tracking form selections. 

 

You will notice the options available on this tab are identical to the options you added to 

your tracking form.  That’s because as you personalize your tracking form to fit your 

needs, this filter tab automatically updates to reflect your changes. 

 

To filter down on just the bills that fit a certain criteria, simply check the box of the type of 

bills you need to pull up.  For instance, if you wanted to see all the bills you’re tracking for 

XYZ Company, you would check the box next to the company name.  You can filter down 

further and see all the Support bills that you’re tracking for XYZ Company by checking 

both boxes. 

 

If you don’t need to filter on a certain category (e.g. you don’t care who the bill is 

assigned to) you do NOT need to check every single box in that category!  Simply leave 

the entire category blank. 

 

Note: Checking multiple boxes within the same category creates an “or” statement, while 

checking multiple boxes from different categories creates an “and” statement.  For 

instance, checking the Oppose and Support boxes (in the Priority category) will display all 

bills that are marked as Support or marked as Oppose.  Checking the Oppose box (in the 

Priority Category) and the Jennifer box (in the Assigned category) will display all the bills 

that are assigned to Jennifer and that are marked Oppose. 

 

Keyword Filters 
This tab is used to find bills that contain certain keywords or phrases.  You can use the 

Keyword Search Bar to quickly find bills with a specific keyword or phrase, but this filters 

tab is a great way to search on multiple terms and to save that parameters of your search 

to run on a regular basis. 
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To search for multiple terms, enter each keyword or phrase on a separate line. 

 
 

This will produce a report that displays every bill in which one or more search terms were 

found. 

 
 

Here are some additional helpful hints when creating a keyword search. 

If you type… … it will find: 

air pollution documents that contain the phrase “air pollution” 

air and pollution documents that contain both the words “air” and “pollution” 

topic contains health documents with the topic containing the word “health” 

author contains hill documents authored by Hill 

coauthor contains jones documents where Jones is listed as a coauthor 

air w/5 pollution documents that have the word “air” within 5 words of 

“pollution” 

air and not pollution documents that only contain the word “air” and not 

“pollution” 

appl* documents that have the word “apple”, “application”, 

“applicable”, etc. 

apply~ documents that have the word “apply”, “applied”, 

“applying”, etc. 

 

 

Code Section Filters 

 
This tab is used to find bills that affect specific code sections. 

 

Just click on the space under Code to see the drop down list of code sections.  Enter the 

section range you’re interested in and press Tab on your keyboard to create another line. 

 

Note: When entering code section numbers in the To field, be careful.  Entering the range 

100.0 to 100.8 will not include code section 100.81.  If you need to include any sub-

section of 100.8, it would be best to enter 100.9 or even 101. 
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Report Actions 

 
When you run a report in the Workspace, you can use the green toolbars above to manage that 

report. 

 

Editing Reports 

 
You’ll notice that when you run a report in your Workspace, the text to the right of Edit 

Current Report will change to describe the report parameters.  To edit your current report, 

simply click on the text and the Report Filters screen will pop-up and let you make 

changes. 

 

Saving Report Parameters 

 
If there are reports that you need to run on a regular basis, you can save the parameters 

of that report so you don’t need to type in the criteria each time.  Simply create your 

report as discussed above, run the report, and click the Save button on the dark green 

toolbar. 

 

Saving your report like this: 

 
 

Saves the report under the Calendars category: 

 
 

 



54 | P a g e   R e v  3 . 2 . 2 2  
 

And displays the Report Name and Description like this: 

 
 

To run the report, click on the report name.   

 

Note: It is important to realize that you are saving the parameters of the report, not the 

results of the report.  If you create and save a report of all your tracked bills on June 24, 

and then begin tracking a new bill on June 25… your report will show all tracked bills 

including the one added on June 25.  Reports are constantly updating in CapitolTrack so 

whenever you run a saved report, you are getting up-to-the-minute information.  If you 

need a report of your tracked bills as of June 24, please be sure to save a copy of the 

report results on your computer. 

 

Print/Email Reports 

  
When you run a report in CapitolTrack, you have the option to Print or Email that report. 

 

Printing Reports 
Click on the Print/Email button, then go to File > Print. 

 

Emailing Reports 
If you use Internet Explorer as your browser, click on the Print/Email button, then 

go to File > Send > Page by Email.   
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This will create a new email in your default email program (e.g. Outlook), and put 

your report in the body of the email.  

 

If your email is suddenly filled with a bunch of funny looking A’s, don’t panic! 

There’s a one-time change to your encoding setting that will fix this problem on 

all future emails.  

 
 

Outlook 2007 

1. On the main Outlook screen, click on Tools 

2. Scroll down and click on Options 

3. Click on the Mail Format tab 

4. Click on the International Options button 

5. Change the “Preferred encoding for outgoing messages” to Unicode (UTF-8) 

6. Click OK.  

 

Outlook 2010 

1. On the main Outlook screen, click on the yellow File tab 

2. In the left column, click on Options 

3. In the left column, click on Advanced 

4. Scroll to the bottom until you see the International Options section 

5. Put a checkmark in the box that says “Automatically select encoding for 

outgoing messages” 

6. Change the “Preferred encoding for outgoing messages” to Unicode (UTF-8) 

7. Click Ok 

 

Outlook 2013 

1. On the main Outlook screen, click on the black File tab 

2. In the left column, click on Options 

3. In the left column, click on Advanced 

4. Scroll to the bottom until you see the International Options section 

5. Put a checkmark in the box that says “Automatically select encoding for 

outgoing messages” 

6. Change the “Preferred encoding for outgoing messages” to Unicode (UTF-8) 

7. Click Ok 

 

Note: This fix will not affect the emails you have already started, but it will fix all 

future emails. 
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Exporting Reports 

 
You have a few options when it comes to Exporting reports.  You can save any report as 

a PDF file in either Portrait (P) or Landscape (L) orientation, you can export the report to 

Word, or you can create a Data File. 

 

The Data File export is great for doing mail merges to create your own custom reports.  

You can also use the Data File export with the Members Roster report or the Committee 

Roster report to do mailing labels or letters.  For help in using the Data File export feature 

to create merges, please call CapitolTrack at (916) 373-0126. 

 

Edit 

 
If you have a saved report that needs to be edited (e.g. you run an Amended Bills report on 

Monday morning and need to go back 3 days instead of 1) you can click on the “Edit” link.  This 

will take you directly to the Report Filters pop-up screen instead of having to run the report first. 

 

Web Link 

 
If you have saved the parameters of your report, you will also have the option to create a Web 

Link for that report.  Web Links are a powerful tool because they allow people to see your reports 

without gaining access to your CapitolTrack account. 
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When you click on the Web Link icon, a screen pops up with a Web Publishing Link and code for 

Search Publishing: 

 
 

Web Publishing Link 

This URL allows someone to view your report without logging into your CapitolTrack 

account. 

 

This is a very powerful feature and you can use it in a variety of ways: 

  

Send it to your clients. 

Giving your client this link allows them to go to the webpage at anytime and always 

receive up-to-the-minute information on their report… without any work on your part!  The 

link will automatically update as you work in CapitolTrack so you don’t need to constantly 

send them new reports.  If the status of one of their bills changes, it will update on the 

report.  If you start tracking a new bill for that client, it will automatically be added.  It 

keeps them constantly in the loop without requiring additional time and effort from you.  

That’s customer service at its finest! 
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Publish it on your website. 

 
CapitolTrack can help integrate your reports into your website, so your members or 

visitors are always getting the updated information you want them to see… and it’s 

coming straight from you because there is no branding on the part of CapitolTrack. 

 

Save it as a button on your browser. 

Turn the link into a Favorites button on your browser so you can get one-click updates on 

your crucial bills. 

 

Calendar Feed 

 
Calendar feeds let you add your entire CapitolTrack calendar to Outlook (or another 

calendar program). Once you add the webcal link to Outlook, it regularly syncs with 

CapitolTrack data and automatically stays up-to-date for you. 
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Please note that this feature does not add hearings to your personal calendar. A 

calendar feed is a separate calendar that can be viewed at the same time. You cannot 

edit events on this calendar feed. (But you also don’t need to do anything to keep that 

calendar up-to-date!) In the screenshot above, you can see the personal calendar (in light 

blue) and the CapitolTrack calendar (in green). 

 

For instructions on how to add the calendar feed to different calendar programs, please 

see Appendix C – Web Publishing Instructions > Adding a calendar feed to your calendar 

program. 

 

Search Publishing 
This HTML lets webmasters to add a search bar to your website.  When the code is 

implemented, it will default to looking like this. 

 
 

Users can type in a bill number or keyword that they are interested in, and all bills in 

CapitolTrack’s system will be searched.  The results of the search will mirror the 

parameters set in the report. 
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There are instructions for webmasters in Appendix C of this User Guide.  Please have 

your webmaster look through the instructions, then call CapitolTrack staff at (916) 373-

0126 if (s)he has any questions. 

 

Note:  Web Publishing is available to all clients for an additional charge.  For current 

pricing, please contact CapitolTrack at (916) 373-0126. 
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My Tools 

 
The My Tools section allows you to manage your CapitolTrack account. 

 

Archive 
Use this section to automatically (un)archive bills. 

Auto-Archive 

 
This section allows you to (un)archive specific types of bills with the click of a button.  If 

you need to archive a specific bill, please use the Search Bar to go to the Bill Information 

screen, and then click the “archive” button for that tracking form.  For more information, 

please see the Tracking Form > Archiving and Deleting Tracking Forms section of the 

User Guide.  There are a few advantages to archiving bills: 

 

It allows you to set aside the bills that won’t be moving so you can focus your 

efforts on the ones that are still working their way through the legislature. 

 

If you subscribe to CT Lite or CT Lite+ (which limit the number of bills you can 

track), archiving a bill reduces your overall count. 

 

If you need to (un)archive a large group of bills with a different criteria than what’s on this 

list, please contact CapitolTrack and we may be able to help you speed up the 

(un)archive process. 

 

Maintenance 
Use this section to maintain parts of your CapitolTrack account. 

 

Email Addresses 

 
If you have signed up for My Bill Alerts, you can manage your corresponding email 

addresses in this section.  To change an email address, simply click on the section 

beneath EMail Address and start typing.  For more information on receiving emails 

anytime the status of your important bills change, please see Workspace – Bill 

Information > My Bills Alerts in the User Guide. 
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Memo Template 

 
If you would like to use rich text formatting to store information on your tracking form, you 

can come here to set up the template for that field.  In this instance, we created a table to 

store information on each version of text for a bill.  This table will appear in the Memo 

field of every tracking form and we can fill in the table from there. 

 

Notifications 

 
Use this section to view, add, and delete the bills each users signed up to receive email 

alerts on.   For more information on receiving emails anytime the status of your important 

bills change, please see Workspace – Bill Information > My Bills Alerts in the User Guide 

 

System Options 
Choose which field you want to track changes for and see which additional CapitolTrack 

features you’re signed up for. 

 

Field Tracking 

 
You can choose to track the changes to a certain field.  Anytime a change is 

made, CapitolTrack will automatically put an entry in the field you specify. 

 

 
In this example, we choose to track the changes we made to the Position field 

and store the history in the Notes 1 field.  These are the changes that 

CapitolTrack logged and anytime we run a report with the Notes 1 field, we will 

see that position changes we’ve made to each tracked bill. 
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Bill Information Tracking Columns 

 
Use this section to pick what information should be displayed on your Bill 

Information screen under the Bill Tracking section. 

 

For instance, you could choose to display the following information on your Bill 

Information page: 

 

 

Other Options 

 
See which optional CapitolTrack features your organization has signed up for. 

 

Multiform – Please see Tracking Form > Adding a Tracking Form 

Web Publishing – Please see Workspace – Reports > Web Publishing 

Gov Matrix – This is used by a very small group of CapitolTrack subscribers.  

Please contact our office to discuss this feature if you feel it could be of use. 
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Tracking Field List 

 
To add options to your tracking form, selection the section, type in the new option you 

want to add, and click the Add button. 

 

 
Use the grid section to manage your tracking options.  Change an option by clicking on 

the current word, and delete an option that is not currently being used by clicking the 

delete link. 
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Links 

 
This section is a great place to find legislative resources.  Some of the sites include: 

Federal Legislative Tracking Website – And it’s free! 

Political News – Updated daily 

California Statues – Find past bills by chapter number 

Assembly, Senate and Joint Rules 
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CT Analyze 

 
After more than a decade of tracking bills, CapitolTrack has built up a huge database of information and 

we’re beginning to develop new features for analyzing bill information. 

 

Vote Record 

 
Use this to view how each member voted on every bill from the entire session. 

 

 
By the end of a two year session, this gets to be pretty long! 
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Vote Shift 

 
This report shows when legislative members change their vote on a particular bill.  It then totals 

the vote changes by type of vote and by party.  A vote shift report is available for all bills that you 

are tracking. 

 

Vote Score 
Vote Score is a powerful tool that allows you to see how often each legislative member is voting 

the way that YOU want them to.  This feature is used in conjunction with the Vote section of your 

tracking form, so please see the Tracking Form > Choose Tracking Selections > Vote, section of 

the User Guide.  There, you will learn how to mark your Vote Favorable preference on each 

tracking form and this will allow you to use the Vote Score application. 
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When you run Vote Score, it will open up an Excel Spreadsheet with lots of columns of 

information: 

  
 

You can then use Pivot Tables in Excel to summarize the data and create statistics.  In this 

example, we marked our Vote Favorable position on seven different bills, and asked it to show us 

how often members voted “for us” and how often they voted “against us.” 

 
Although it doesn’t display in this example, we can also see the Vote Score breakdown by bill 

number, by party, by district, etc.  For help with this, please call CapitolTrack at (916) 373-0126. 
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CA Chapter Code Index 

 
The CA Chapter Code Index displays all codes sections that have been affected by a chaptered 

bill during this legislative session.  It will also indicate whether or not you were tracking that 

chaptered bill. 
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Appendix A – How to Create Common Reports 
Appendix A contains step-by-step instructions on how to create common reports.  If there are no 

instructions for a certain section of the Report Filters screen, please leave the default selections.  If you 

have any questions when creating reports in CapitolTrack, or it’s taking you more than five minutes to 

create the report you need, don’t ever hesitate to call the office at (916) 373-0126. 

 

When you create these reports, please remember you have the option to save the reports to run them on 

a regular basis.  For more information on saving reports, please see Workspace – Reports > Managing 

Reports > Saving Report Parameters in the User Guide.  

 

Calendar of My Bills 
Go to Workspace 

Click on New Report 

On the Report View Tab: 

Primary Header: Calendar of Tracked Bills 

Secondary Header: &d 

Format: Calendar 

Check the following boxes: 

Calendar 

At the top right corner, click Close and refresh report 

 

Status Report of My Bills 
Go to Workspace 

Click on New Report 

On the Report View Tab: 

Primary Header: Status Report 

Secondary Header: &d 

Check the following boxes: 

Current Text Version Link 

Status 

Calendar 

Summary Brief 

Progress Bar 

Organization (optional if using this field on your tracking form) 

Assigned (optional if using this field on your tracking form) 

Position (optional if using this field on your tracking form) 

Priority (optional if using this field on your tracking form) 

At the top right corner, click Close and refresh report 
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Recently Introduced Bills Report 
Go to Workspace 

Click on New Report 

On the Report View Tab: 

Primary Header: Introduction Report 

Secondary Header: &d 

Check the following boxes: 

Current Text Version Link 

Summary Brief 

Manage Bill Links 

On the Bill Filters Tab: 

Source: Check Tracked, Nontracked, and Archived 

Versions: From <leave blank> through TODAY or in the last 3 days 

Check only the Introduced box 

At the top right corner, click Close and refresh report 

Note: You can change how far back this report will look for introduced bills.  If you need 

all bills introduced within the past week, please enter 7 instead of 3.  If you need all bills 

introduced yesterday, please enter 1. 

 

Recently Amended Bills Report 
Go to Workspace 

Click on New Report 

On the Report View Tab: 

Primary Header: Amended Report 

Secondary Header: &d 

Check the following boxes: 

Current Text Version Link 

Summary Brief 

Manage Bill Links 

On the Bill Filters Tab: 

Source: Check the Tracked, Nontracked, and Archived boxes 

Versions: From <leave blank> through TODAY or in the last 3 days 

 Check only the Amended box 

At the top right corner, click Close and refresh report 

Note: You can change how far back this report will look for amended bills.  If you need all 

bills amended within the past week, please enter 7 instead of 3.  If you need all bills 

amended yesterday, please enter 1. 
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Keyword Search 
Go to Workspace 

Click on New Report 

On the Report View Tab: 

Primary Header: Keyword Search 

Secondary Header: &d 

Check the following boxes: 

Current Text Version Link 

Summary Brief 

Manage Bill Links 

On the Bill Filters Tab: 

Source: Check the Tracked, Nontracked, and Archived boxes 

On the Keyword Filters Tab: 

Enter your keywords or phrases, one per line 

At the top right corner, click Close and refresh report 
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Appendix B – Customize Your CapitolTrack Account 
CapitolTrack offers a variety of ways to personalize your account to fit your organization’s need.  Below 

are some of the options available to all CapitolTrack clients. 

 

Personalized Formats 
Report formats are discussed in the Workspace – Reports > Create a New Report > Report View 

Tab > Formats, section of the User Guide.  However, you may need your report to look a specific 

way that none of our standards formats can create.  In cases like this, CapitolTrack offers 

Personalized Formats free of charge.  Just draw us what you would like your report to look like, 

and we will create a format that’s available to just your organization that displays your report the 

way you want to see it. 

 

Some of the requests we’ve had in the past include: 

 Adding multiple fields to one column (e.g. measure, author, and position are all in the first 

column) 

 Turning certain fields a different color or making them bold (e.g. displaying calendar 

events in red, or making “support” bills green and “oppose” bills red) 

 Adding a logo and company contact information to the top of reports 

 
Sample personalized format 
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Personalized Labels 
In the section, Tracking Form > Managing and Using Tracking Forms > Current Tracking 

Selections, we discussed how CapitolTrack can personalize the fields on your tracking form.   

 

If you would like to make changes to your tracking form, please fill out the form following page 

and email or fax it to CapitolTrack. 

 

Personalized Email Notifications 
We can customize the information that is displayed in the subject and the body of your email 

alerts.  Please use this form to tell us what information should be included. 

http://www.capitoltrack.com/PersonalizedNotifications/tabid/442/Default.aspx
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CapitolTrack 

Personalized Labels Request Form 
 

CapitolTrack now allows you to personalize your Tracking Field labels.  Please submit 

this completed form and our staff will customize your company’s labels. 

 

Company:       

Contact Person:       

 

    

Default Label Change to 

Organization†       

Assigned*       

Position†       

Priority†       

Subject*       

Office*       

Suboffice*       

Group*       

Misc1†       

Misc2†       

Due Date**       

Notes 1‡       

Notes 2‡       

Notes 3‡       

Memo‡       

 

   * Field supports multiple selections in the form of check boxes 

   † Field supports a single selection in the form of radio buttons 

   ** Field is a date 

   ‡ Field is a text box 

 

Please email this completed form to support@capitoltrack.com or fax it to (916) 373-

0459. 

mailto:support@capitoltrack.com
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Appendix C – Web Publishing Instructions 
CapitolTrack uses XML and XSLT to integrate up-to-the-minute legislative information into your website.  

The following instructions are primarily for webmasters who will be integrating CapitolTrack reports into 

client web pages.  You should have a good working knowledge of HTML for this to be helpful. 

 

Generating the unique link for a report 
The CapitolTrack user should login to his/her account, create and save the parameters for a web 

report.  We recommend creating a new category called “Web Reports” so that all users are can 

find the reports that are live on your website.   

 
 

Once the report is saved, click on the Web Link icon to generate the unique link for this report. 
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Integrating the report into your website 

Option 1 – Use an iFrame tag (preferred method) 

Place the report inside an iFrame tag.  (This works especially well if you are using 

Content Management software.)  You can set the border, height and width to fit with your 

site, and our office can personalize the report fonts, colors, etc.  To display the entire 

report without scroll bars, set the iFrame height and width to 100%. 

 

Sample: 

<iframe frameborder="0" width="670" height="600" src="http://ct3k1.capitoltrack.com/... 

your unique link here” /> 

Option 2 – Insert the HTML  

This is the preferred method since any changes to the website, menus or graphics are 

maintained on your site.  Below is sample code using ASP and PHP code.  Note: You 

should use the unique link from your CapitolTrack account in lieu of the sample one 

below. 

Using ASP code 

<% 

Set objXML = CreateObject("MSXML2.ServerXMLHTTP") 

objXML.open "GET", 
"http://www....your header html here", False 

objXML.send() 

header_Source = objXML.responseText 

 

objXML.open "GET", 
"http://www....your footer html here", False 

objXML.send() 

footer_Source = objXML.responseText 

 

Set objXML = CreateObject("MSXML2.ServerXMLHTTP") 

objXML.open "GET", 
“http://ct3k1.capitoltrack.com/… your unique link here” 

False 

objXML.send() 

content_Source = objXML.responseText 

 

Set objXML = Nothing 

%> 

 

<!DOCTYPE HTML PUBLIC "-//W3C//DTD HTML 4.01 Transitional//EN"> 

<html> 

<head> 

<title> 

</title> 

<% response.Write(header_Source) %> 

<% response.Write(content_Source) %> 

<% response.Write(footer_Source) %> 
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Using PHP code 

<?php 

 

        $ch = curl_init("http://ct3k1.capitoltrack.com/… your unique link here "); 
        curl_setopt($ch, CURLOPT_HEADER, 0); 

        curl_setopt($ch, CURLOPT_FOLLOWLOCATION, 1); 

        curl_setopt($ch, CURLOPT_RETURNTRANSFER, 1); 

curl_setopt($ch, CURLOPT_COOKIEFILE, $cookie_file_path); 

        $output = curl_exec($ch);       

        curl_close($ch); 

        echo $output; 

?> 

Option 3 – Use a Content Management site 

If your website uses Content Management Software you may be able to insert html from 

a source link.  (Note: iFrames can be used with this method as well.  Please see Option 1 

for more information.) 

Option 4 – Add the link to your site 

You can submit and host a personalized stylesheet. .  This is the least preferred method 

because CapitolTrack must be updated anytime you make changes to the main portions 

of your website. 
 

If choosing this option, please adhere to the following XSL standards: 

1. All tags must be closed.  (e.g. meta and image tags)  You can choose to use 

</tagname> or <tagname……/> to close 

2. All references to URL’s must be absolute  (e.g. they should all start with http://)  

This includes images, scripts, etc. 

3. Character codes should be used: 

 The literal & sign must be coded as &amp; 

 The literal < sign must be coded as &lt; 

 The literal > sign must be coded as &gt; 

 Use of &nbsp; (non breaking space) must be coded as &#160; 

 Use of &copy; must be coded as &#169; 

 

Please be sure to test your html before submitting it to CapitolTrack.  It should be one file 

(.htm or .html), and you should be able to open the file from your local hard drive and 

view all functions. 

 

Webmasters who are not familiar with XSLT and would like us to create the stylesheet 

may submit a stand-alone webpage in HTML.  When submitting the HTML, place 

<div>INSERT REPORT CONTENT HERE</div> 

In the html page and we will add the XSLT syntax in this spot.  For example: 

 

<html> 

<head> 

<title>sample page</title> 

<style type="text/css"> 

 a {color:blue} 

 P {font-size: 10pt; font-family: Arial; vertical-align: top} 

</style> 

http://en.wikipedia.org/wiki/List_of_content_management_systems
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</head> 

<body bgcolor="#FFFFFF" leftmargin="0" topmargin="0" link="#000000" 

vlink="#999999"> 

<h1>Welcome to our site</h1> 

<div> 

INSERT REPORT CONTENT HERE 

</div> 

</body> 

</html> 

Printable Version of the Report 

To provide a printable version of the report(s) embedded in your website, you can include 
a link to a “Printable Version” of the report. For example: 
 
<a href=”http://ct3k1.capitoltrack.com/… your unique link here” target=”_blank”>Printable 
Version</a> 
 
Important Note: The ampersands (&) in the unique link needs to be replaced with 
(&amp;)  For example: 
http://ct3k1.capitoltrack.com/public/publish.aspx?session=11&id=..... Becomes 
http://ct3k1.capitoltrack.com/public/publish.aspx?session=11&amp;id=.....
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Picking the legislative session 
The unique link generated by CapitolTrack includes an argument that specifies which legislative 

session bills should be displayed from. 

 

Always show bills from the 2011 legislative session: 

http://ct3k1.capitoltrack.com/public/publish.aspx?session=11&id=0853a04d-9e9c-4e95-a1e1-

91bbfe6ecb 

 

If the report should always show bills from the current legislative session, remove the session 

argument from the unique link: 

 

Always show bills from the current legislative session: 

http://ct3k1.capitoltrack.com/public/publish.aspx?id=0853a04d-9e9c-4e95-a1e1-91bbfe6ecb 

 

Adding a search bar to your website 
CapitolTrack provides the code to insert a bill/keyword search bar on your website. 

 
 

To get the HTML code for the search bar, click on the Web Link icon (like you did to generate the 

unique link), and use the code in the Search Publishing section. 

 
Important Note: Any tracking form information that is displayed on the corresponding report will 

also be displayed in the results of a search.  For instance, if the report displayed the position and 

priority for each bill, the results of a search using this code will also display the position and 

priority for each bill. 
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Adding a calendar feed to your calendar program 
CapitolTrack provides webcal links so you can subscribe to the calendar feed. Please do the 

following: 

 

Click on the category in the left column where your calendar is saved. 

 
 

Click on the Web Link icon next to your calendar, and copy the link in the Calendar Feed box. 

 

 
 

 

Add a Calendar Feed to Outlook 2007 

1. Go to your Outlook Calendar 

2. Click on Tools > Account Settings… 

3. Click on the Internet Calendars tab 

4. Click on New 

5. Paste the “webcal://ctweb.capitoltrack.com...” link in the box and click Add 

6. Click Ok 

7. Press the F9 button on your keyboard. (This will sync the calendar to Outlook.) 

8. In the left column, the calendar will be visible in the Other Calendars section 

 
9. Check the box next to calfeed to see your CapitolTrack calendar 

 

Add a Calendar Feed to Outlook 2010 or Outlook 2013 

1. Click on the Web Link icon next to your calendar 

2. Copy the “webcal://ctweb.capitoltrack.com...” link  

3. Go to your Outlook Calendar 

4. In the left column, right-click on Other Calendars 

5. Click on Add Calendar > From Internet 

6. Paste the “webcal://ctweb.capitoltrack.com...” link in the box and click Add 

7. Press the F9 button on your keyboard. (This will sync the calendar to Outlook.) 
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Add a Calendar Feed to Google Calendar 

1. Click on the Web Link icon next to your calendar 

2. Copy the “webcal://ctweb.capitoltrack.com...” link  

3. Go to your Google Calendar 

4. In the left column, click on the down arrow next to Other calendars 

5. Click on Add by URL 

6. Paste the “webcal://ctweb.capitoltrack.com...” link in the box and click Add 

Calendar 
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